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Introduction 
Manual MET/CAL® Calibration Management Software is a paperless calibration system 
used to collect and report calibration data. Unlike paper-based spreadsheets and forms that 
take up storage space, Manual MET/CAL software saves all calibration results and records 
in the MET/CAL® and MET/BASE databases. This tool calibrates more than one item at a 
time and captures both as-found and as-left readings. 

If you already use MET/CAL® Plus software to automate part of your calibration 
workflow, now you can use Manual MET/CAL for the remaining workload. 

New in Version 2.0 and 2.1 

New features are available in Version 2.0 and 2.1: 

Version 2.0 
• Additional datasheet development tools 

• Additional run-time capabilities, including the ability to hibernate a calibration for later 
completion 

• Batched Crystal Reports 
• Single-click printing for sticker, certificate of calibration, and all other calibration reports 
• Optional datasheet approval system 
• Batch-assigned datasheets to specific assets 
• Datasheet import/export 
• New test types available 
• Measurement uncertainty entry 
• N/A test entry 
• Decimal placeholder control 
Version 2.1 
• Supports MET/CAL Version 7.2 and 7.3 
• Supports Microsoft Windows 7 and Vista (32 and 64-bit operating systems) 
• Supports multiple language selection from the Tools menu (English, French, German, 

Italian, Portuguese, and Spanish) 
• Measurement Uncertainty value is now written to the Expanded Uncertainty column in 

the results table 
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Installation 

The installer program ships on a USB Flash Drive. Install the software on a workstation by 
running: 

Fluke Manual METCAL 2.#.exe (# = version number) 

See your IT department if you do not have install permission on your computer. 

Minimum System Requirements 

Either MET/CAL® or MET/TRACK® Version 7.0 software or later must be installed 
before installing and running Manual MET/CAL software. You should understand the 
operation of MET/TRACK software, as it is the primary searching and browsing tool for 
calibration records added by Manual MET/CAL software. A display screen with 
1024 x 768 resolution or greater is highly recommended. 

Security 

Manual MET/CAL software is a secure system that requires both a User ID and a 
Password for operation. The MET/CAL System Manager can create these for you. Manual 
MET/CAL conforms to the MET/TRACK security model, permission system, and 
customizing. 

First Time Operation 

When using Manual MET/CAL Version 2.1 software for the first time, the database must 
be initialized. After logging in with your MET/CAL User ID and Password, you will be 
prompted to enter the System Manager (MT) password so the database can be initialized. 
The system manager may need to do this for you. Users new to this software will want to 
read “Learning and Experimenting” on page 43. 

Users upgrading from previous versions will also need to login as the system manager so 
the database can be patched for Version 2.1 operation. 

Licensing 

You must have an installed license to use Manual MET/CAL. See “Installing a License” 
on page 45. Additional concurrent licenses can be purchased from your Fluke 
representative. 
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Languages 
The user interface for Manual MET/CAL Version 2.1 is available in several languages: 
French, German, Italian, Portuguese, and Spanish. To change the language, go to the 
Tools menu, see Figure 1. 

 
ggl070.bmp 

Figure 1. Language Selection 

How to Contact Fluke 
To contact Fluke, call one of the following telephone numbers: 

• Technical Support USA: 1-800-44-FLUKE (1-800-443-5853) 

• Calibration/Repair USA: 1-888-99-FLUKE (1-888-993-5853) 

• Canada: 1-800-36-FLUKE (1-800-363-5853) 

• Europe: +31 402-675-200 

• Japan: +81-3-3434-0181 

• Singapore: +65-738-5655 

• Anywhere in the world: +1-425-446-5500 

Or, visit Fluke's website at www.fluke.com. 

To register your product, visit http://register.fluke.com. 

To view, print, or download the latest manual supplement, visit 
http://us.fluke.com/usen/support/manuals. 
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Toolbar and Menus 
The toolbar has three buttons: Calibrate, Reports, and Designers, see Figure 2. The 
Calibrate button initiates a calibration. The Report button opens access to the reports. The 
Designers button opens access to the datasheet designer. Permission to use these tools and 
capabilities conforms to the MET/TRACK® security system. Datasheets are treated like 
MET/CAL® procedures. As an example, if the System Manager has revoked your privilege 
to edit procedures, you will not be able to use the Datasheet Designer to edit datasheets. 

The Toolbar turns on or off from the Tools menu. All Toolbar functions are available in 
the menu system also. 

 
ggl001.bmp 

Figure 2. Manual MET/CAL Interface 

Datasheets 
A datasheet is an electronic form for recording calibration readings and values. It consists 
of one or more rows that describe each test and verify performance. Manual MET/CAL 
software compares measurements to test limits and determines a pass/fail status. 
Optionally, a datasheet can include instructions about how to perform the calibration. 

A test step includes a test value and test limits as well as the results evaluation methods. At 
run-time, you follow the instructions and complete the datasheet for each step. When the 
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calibration is complete, you save the contents of the datasheet to the database. Once saved, 
you can display, export, or print data in a report. 

A Manual MET/CAL software datasheet is similar to popular GIDEP and NAVAIR 
calibration methods. 

Creating a Datasheet 

The Datasheet Designer creates a datasheet. To display the Datasheet Designer, click the 
Designers button or push F6. Several datasheet examples are available from the Examples 
menu. Figure 3 is a simple four-line datasheet. Each row represents a test the technician 
performs at run-time. 

 
ggl002.bmp 

Figure 3. Datasheet Designer 

Creating an Ammeter Datasheet 

As an example, this section explains how to create a datasheet for a 3½-digit ammeter. The 
input is fuse protected and has a single 1.000 amp range. The calibration manual states that 
the full-scale accuracy is ±3 digits. The calibration manual also states that at zero input, the 
meter should read ±2 digits or less. 

To create a datasheet for this item: 

1. Check that the input fuse is not open. 

2. Verify that all display segments are working. 

3. Create a test to verify the zero input accuracy. 

4. Create a test to verify the full-scale accuracy. 

When you begin, there will be a single test row. 

5. Click the Test Type cell. 

6. Select the Check test type from the drop down list. 

7. Type Is the Fuse OK? into the Test Value column. 
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To check that the display segments are all OK: 

1. Click Append to add a new datasheet row.  

2. Select the Check test type. 

3. Type Are all display segments OK? into the Test Value column. 

Tests three and four test the zero and full-scale accuracy: 

1. Append a new row for test three. 

2. Enter the description and select Less than Passes for the test type. 

3. Enter the test level of 0.000 into the Test Value column and 0.002 into the High Limit 
column. 

4. Append a new row for test four. 

5. Create the full-scale test using Inside Limits Passes as the test type. 

6. Add the low and high limits. 

After you enter all the test steps, the datasheet looks like Figure 4. 

 
ggl004.bmp 

Figure 4. Datasheet Example 

Creating a Micrometer Datasheet 

This example is for a 1-inch micrometer. To create a datasheet for a micrometer: 

1. Select New from the File. 

2. Add steps to datasheet. 

The calibration procedure for the micrometer can potentially include the following checks 
and tests. The preceding datasheet is available from the Examples menu. 
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Checks 
• Item is clean and undamaged 
• Thimble moves freely 

Flatness Test 
• Anvil face: 0.000005 inches max 
• Spindle face: 0.000005 inches max 

Length Tests 
Table 1 is an example of the Length Tests. 

Table 1. Length Tests 

Length Low Limit Hi Limit 

0.0000 0.0001  

0.1950 0.1949 0.1951 

0.3900 0.3899 0.3901 

0.5850 0.5849 0.5851 

0.7800 0.7799 0.7801 

1.0000 0.9999 1.0001 

The information from the micrometer specifications and calibration procedure has been 
entered into the datasheet. Figure 5 is the completed micrometer datasheet. 

 
ggl005.bmp 

Figure 5. Completed Micrometer Datasheet 
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Datasheet Designer Wizards 

Wizards are available to speed the datasheet design process. In the example 
shown below, information about a test has been entered including the device 
specification. 

Single Test Wizard 
After you enter all information, click the Single Test Wizard button to create 
the test shown in Figure 6. In this example, the wizard calculates the limits 
based on the specification. 

Note 
TUR and Uncertainty are not calculated. They must be determined 
independent of the software and entered into the datasheet. Once 
entered, they will be included in the calibration test results at run-
time. 

 
ggl008.bmp 

Figure 6. Datasheet Designer Wizard 

Multistep Wizard 
The wizard also generates a sequence of tests over a range of test values: 

1. Check the Multi-line box. 

2. Enter the Start, End, and Step Size values and the accuracy. 

3. Click Check. 
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In Figure 7, the datasheet has Test Values from 0 to 100 volts in 20-volt steps. There are 
several important points to notice: 

• If the test value is 0, and the specification is a percentage or a PPM of reading, or full-
scale, the limits calculate to 0.00. You will need to enter a new set of limits at this test 
value. In other words, 1% of 0.00 is zero. 

• If the number of decimal places is blank, the software determines the number of places 
based on the resolution needed to display the test limit.  

• For computing the contribution of the %FS specification, the full-scale value is equal to 
the End Value. 

 
ggl009.bmp 

Figure 7. Datasheet Test Values 

Transducers 

The term “transducer” describes a device that detects a parameter in one form and reports 
it in another, such as a pressure transducer or a temperature to current transducer. These 
devices may also be called transmitters. 

Manual MET/CAL software can create calibration procedures for transducers. To enable 
this mode, click the Transducer button, see Figure 8. The software adds columns for the 
transducer input values and units. 
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ggl010.bmp 

Figure 8. Calibration Procedure for Transducers 

The Transducer Wizard created this datasheet. Use the wizard to define both the input and 
output conditions. The software performs the mathematics to complete the datasheet. 

Datasheet Column Descriptions 

A test consists of a row of information with individual columns for data. 

 
ggl011.bmp 

Test Step – A test reference to identify a test. The format is set from the Tools Menu. 

Test Description – Optional information to describe the test. This field is not intended for 
instructions. It is best to use this field as information about the test or type of test. 
Examples could be full-scale test, flatness test, or output power. 

Test Type – The test evaluation method. 

Input Value – Transducer only. This is the transducer input test value. Enter a number 
such as 1.00. 

Units (Input) – Transducer only. Units for input. Volts, mA, degrees, and PSI are 
examples of typical units. Right-mouse click this cell to paste in other hard-to-find 
symbols. 
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Test Value – For tests evaluated numerically, this is the nominal test value such as 1 volt, 
100 PSI, or 3 mm. For text-based tests that require a Y/N response, this is a question or a 
statement, such as Are all display segments working? or Does the thread work 
smoothly? If the calibration item is a transducer, this is the output measurement. 

Units (Output) – Output units such as ft/Lbs, PSI, or Amps. Right-mouse click this cell to 
paste hard-to-find symbols such as µ, or ºC or In². 

Low Limit – A numeric value that indicates the low pass/fail point. 

High Limit – A numeric value that indicates the high pass/fail point. 

Note 
Some test types use a single limit. Always enter the single limit in the 
Low Limit column. 

Places – The number of decimal places after the decimal point (optional). 

TUR – The computed Test Uncertainty Ratio of the test (optional). 

Uncertainty – The computed uncertainty of the test (optional).  

Test Type 
Test type determines how the software evaluates test readings at run-time. Ten test types 
are available from a drop down list. The list displays when you select the test types 
column. After selection, a graphic displays in the column. Figure 9 is simple datasheet that 
uses all of the test types. 

 
ggl010a.bmp 

Figure 9. Test Types 
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Inside limits pass ( ) – The test passes if the reading falls within the low and 
high test limits. 

Less than passes ( ) – The test passes if the reading is less than the low limit. 

Greater than passes ( ) – The test passes if the reading is greater than the low 
limit. 

Y = Pass ( ) – If the answer is Y in response to a question, then the test passes. 

Y = Fail ( ) – If the answer is Y in response to a question, then the test fails. If the 
answer is N in response to a question, then the test passes. 

Check ( ) – Not actually a test, it is a record that the user has performed an action, such 
as checking a fuse or the condition of a screw thread. 

Blank Line – This is not a test. It is a spacer, comment line, or blank row. Use it to put 
empty rows in a test report. 

Label & Bold Label – Indicates the type of tests that follow. Bold Labels print as bold 
text on Crystal Reports. 

Enter Text – At run-time, respond to a prompt and enter a value or message. This text 
prints in the calibration report. 

Designer Buttons 

 
ggl013.bmp 

Use these buttons to: 
• append test rows to the datasheet 
• insert a row at the current line 
• duplicate lines and multiply them by 10 
• delete an individual test 
• delete all tests 

 
ggl014.bmp 

These buttons are for datasheet management. Use these to: 
• load existing datasheets 
• check that the datasheet limits are OK 
• save the datasheet to the database 
• set the operation mode with the Transducer button 
• enable the Test-Step Wizard 
• enable the Instruction Wizard 
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Datasheet Designer Hot-Keys 

Table 2 is a list of the Hot-Keys for the Datasheet Designer. 

Table 2. Datasheet Designer Hot-Keys 

Hot-Key Action 

CTRL + A Appends a new row 

CTRL + I Inserts a new test row 

CTRL + T Duplicates the current row 

CTRL + * Duplicates a test on a new row and multiplies values by 10 

CTRL + P 
Copies the datasheet to the Windows clipboard (handy if 
pasting into Excel spreadsheet) 

CTRL + V Pastes a datasheet from the Windows clipboard 

Checking the Datasheet 

Before saving, you must check the datasheet with the Check button. This insures 
proper use of the columns and limits for each test type. After this check, the 
Save button enables and you can save the datasheet to the database. 

 

Saving the Datasheet 

Click the Save button to add this datasheet to the datasheet library.  

By default, the software requires that the datasheet name is unique. This means 
that the name cannot be the same as any other datasheet. Optionally, you can set 
the software to an alternate mode where the combination of name + Mfg + 

Model is unique. This assigns a generic datasheet that you can use with various models. 
See “Options and Customizing” on page 39 for more details. 
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If a datasheet is for a specific model, enter that information in the Manufacturer, Model, 
and Description fields, see Figure 10. To select this information directly from the database, 
click the button to the right of the fields and select an asset from the list. Also indicate if 
the UUT is a measurement or source item. 

 
ggl017.bmp 

Figure 10. Saving a Datasheet 

Hibernation 

Manual MET/CAL software includes the option to hibernate, or pause, a calibration and 
resume later. This is helpful for lengthy calibrations of items such as thread gage sets 
where calibrations may take more than one workday. To allow datasheet hibernation, 
check the Allow Hibernate while calibrating checkbox. 

Changing Datasheet Properties 

To save a datasheet during development, click the Save icon. However, to edit the 
datasheet information on the Save form, select Save from the File menu. 

Making a Copy of a Datasheet 

Select Save As from the File menu to make a copy of a datasheet. The Save dialog box 
displays to enter a new name for the datasheet. 
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Instruction Designer 

To create and save instructions for the datasheet to the database, the software includes a 
word processor, see Figure 11. Multiple datasheets can use the instructions during a 
calibration. The word processor provides writing and editing capabilities. Since the use and 
operation are similar to other word processors such as Microsoft Word®, this manual does 
not include instructions on the use of all of the features. 

If you prefer, you can create the instructions in another word processor tool and then paste 
them into the Manual MET/CAL word processor. These internal instruction documents are 
known as Manual MET/CAL documents or MMCs. You can import a TXT or RTF format 
file directly into the instructions. 

 
ggl018.bmp 

Figure 11. Instruction Designer 

Saving Instructions 
Click the Save button to save instructions to the database. This opens the Save 
dialog box in Figure 12. Enter a title and other descriptive information. 

Note 
The title must be unique for each document. 
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ggl020.bmp 

Figure 12. Saving Instructions 

Attaching Instructions to a Datasheet 
You can assign instructions to multiple datasheets. MMC documents are the most flexible 
because during a calibration the instructions display on the run-time screen in the software. 
For increased security, the software saves and backs up the MMC documents to the 
database. 

To create instructions: 

1. From the Datasheet designer, click Instructions to display the 
Instruction Wizard shown in Figure 13. 

2. Click Open. 

3. Select an instruction type. 

4. Click Select. 

5. Select an internal document (MMC), or navigate to an external 
document. You may also enter a URL path for where the software can 
find the instruction file on the Web. 

 
ggl022.bmp 

Figure 13. Instruction Wizard 

The software displays several instruction types: 
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MMC documents are instructions created with the MMC instruction editor and retained 
within the database. 

External documents are files such as Microsoft Word or Adobe PDF files that are 
available to the workstation. 

Web documents are files viewable in a Web browser. 

Note 
Always check and save the datasheet after making changes. 

Figure 14 shows the calibration run-time with instructions. Generally, these instructions 
are internal documents loaded from the MET/TRACK® database. However, you can open 
files with an RTF or TXT file extension from other network locations. 

 
ggl023.bmp 

Figure 14. Calibration Run-Time with Instructions 
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Approving Datasheets 

If the datasheet approval system is enabled, new and revised datasheets will be marked as 
unapproved when saved. You cannot use an unapproved datasheet in a calibration until a 
level 4 or 5 operator approves the datasheet. 

The datasheet approval screen is accessible from the Tools menu. After review, the level 4 
or 5 operator approves the datasheet by checking it off, see Figure 15. A notes window is 
available to add comments about the approval. 

 
ggl024.bmp 

Figure 15. Datasheet Approval Manager 



 Datasheet Edition 
 Datasheets 

19 

Setting the Default Datasheet Name 

This productivity enhancement tool allows the user to set the default calibration datasheet 
quickly for multiple items. In Figure 16 the asset list uses a filter to display only Fluke 
model 8846A multimeters. Both of them were selected, and the datasheet for this item 
highlighted in the left panel. The default datasheet field (I4241) updates when you click 
Assign. To make the changes permanent, click Save. 

 
ggl025.bmp 

Figure 16. Datasheet Assignment 
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Calibration 
This manual section is about how to use a datasheet for calibration. To calibrate, you 
follow the instructions and, as each test step is complete, enter the test values into the 
datasheet. When all steps are complete and the calibration data is entered, the results are 
written to the database. After saving, you can print reports. 

To start a calibration: 

1. Click Calibrate. 

2. Select Calibrate Instruments from the Calibrate menu or push F2. 

 
ggl026.bmp 

Figure 17. Calibration Run-Time 

Use the screen in Figure 17 to select the items to calibrate, the datasheet to follow, and the 
calibration standards to use. 

Items to be Calibrated – Asset numbers are typed or scanned from a bar-code reader. 
After entering the item’s asset number, push Enter or click the Check button. You can 
select assets from a drop down asset list also. In this example, two Fluke model 87s are 
ready for calibration. 

Datasheet to Use – Once you select an item for calibration, the Default Calibration name 
displays in the Datasheet to Use window if the datasheet is valid. If the procedure name 
for the default calibration has not been assigned to the item, click Select DS to select a 
datasheet. To make this the permanent calibration datasheet, click Update DB. This will 
update the Default calibration field for this asset in the database. 

Calibration Standards – To select the Calibration standards to use, type or scan the asset 
number or select from a dropdown list. 
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How to Start a Calibration 

After selecting the calibration items, the datasheet, and the calibration standards, click the 
Calibrate tab to start the calibration. Figure 18 shows a simple item that is ready for 
calibration data entry as each test is complete. Once complete, the Save button enables and 
you can save the results. With the Reports button, you can view and print reports. This 
example shows two calibration items. Each has its own column for calibration data. 
Readings outside of the limits show in red, and if enabled, the optional out-of-tolerance 
beeper sounds. 

 
ggl028.bmp 

Figure 18. Start a Calibration 

Numeric Test Types – When the Test Type is Between the limits passes, Less than 
passes, or Greater than Passes, the data is limited to numeric input. After you complete 
the data input, push Enter. 
Check Test Types – Push the keyboard spacebar or the letter C to toggle the reading. 
Yes/No Test Types – Push either the keyboard spacebar, the letter Y, or the letter N to 
toggle the reading. 
Test Entry Test Type – Any combination of letters and numbers is acceptable. 
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Viewing Calibration Instructions 
The software attaches calibration instructions to a datasheet. To open attached instructions, 
click the Instructions button on the left of the window. This button is disabled if the 
datasheet does not have instructions attached. You also can toggle the instruction display 
on and off with this button. 

The run-time screen with instructions is split vertically. The datasheet is on the 
top and the instructions below, see Figure 19. You can read the instructions as 
you do your work and complete the calibration data input in the datasheet. The 

horizontal splitter bar between the instructions and the datasheet resizes the window 
height. 
External instructions display in the native application environment. For example, an MS 
Word document displays in MS Word, not in the datasheet. You can toggle or hot key 
between the worksheet and MS Word to view the instructions. 

Note 
Be sure to close the external application after saving the calibration results. 

 
ggl030.bmp 

Figure 19. Viewing Calibration Instructions 
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Viewing External Calibration Instructions 

Some instruction files such as a PDF or a Word document, cannot display directly in 
software. At the beginning of a calibration, these instruction documents are loaded in their 
native application for viewing. For example, both the Manual MET/CAL software and 
Microsoft Word can be open at the same time. To view the instructions in Word during a 
calibration, toggle the display between Word and the Manual MET/CAL software. 

Figure 20 shows that the calibration window is available for data input and the instructions 
show in a separate Adobe Acrobat window. 

 
ggl031.bmp 

Figure 20. External Calibration Instructions 

Note 
The workstation must have the document’s native application in 
order to view external documents during calibration. 
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Advanced Run-Time Features 

In Figure 21 the buttons on the left side of the run-time screen allow access to additional 
features: 

• Found-Left Button 
• Set Actual Readings 
• Average Readings Button 
• Add Notes Button 

Capturing As-Left Data 
An out-of-tolerance reading displays in red. If you can correct the problem 
during calibration, the software can capture the as-left data. In this example, test 
1.05 is out of tolerance and displays in red. 

 
ggl033.bmp 

Figure 21. Advanced Run-Time Features 

After you adjust an item into correct operation, click the Found-Left button. This opens an 
As-Left column for the item. This example shows the in-tolerance as-left reading. 
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Adding Notes 
To record a note or comment about a test, click the Note button. Cells containing 
a note have a blue background. In test 1.05, Asset 1-1 has an attached note. 

 
ggl035.bmp 

Averaging Readings 
Use averaging to capture noisy or non-repeatable readings. Input each test 
reading, and then push Enter. Readings can be entered from the keyboard or 
slewed up and down using the keyboard arrow keys The software adds each 

reading to the list. After you enter all values, click OK. The software pastes the average 
value into the test cell. The number of readings and the standard deviation record with the 
calibration results. 
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Setting a Test to N/A 
If you are unable to perform a test, set the test to N/A. Include a note with an explanation. 
This will not affect the pass/fail status of the calibration. 

Setting the Actual Test Value 
You can set the actual test value when the true value of the calibration standard is not equal 
to the nominal. For example, when you weigh a 10-pound weight and find that it is 
actually 9.8 pounds. Or, when using a hand pump, the pressure cannot be set to exactly 100 
PSI. Instead, the closest pressure setting is 100.4 PSI. 

To set the Actual Test Value of a single test: 

1. Hold the mouse over the Test Value to change. 

2. Right-click the mouse. 

3. Select Set Actual. 



Manual MET/CAL Calibration Management Software 
Users Manual 

26 

4. Use the arrow keys to slew to the actual value of the calibration standard. 

5. Click OK. 

 
ggl069.bmp 

After the actual value is set, the software displays the actual value in blue preceded by the 
@ symbol. The limits shift an equal amount. 

 
ggl039.bmp 

If several actual values are to be set, click the Set Actual button and choose Set 
All. A column labeled, Actual, displays. You can change the nominal values as 
needed. Again, click the Set Actual button again to hide this column. 

Hibernating a Calibration 

The Hibernate function stops a calibration before it is complete. When you save 
the datasheet, the hibernate function is available as option. 

When a calibration is hibernated, the software saves all of the input data to the 
database. Later, you can reload this data and resume the calibration. 

Hibernation Rules 
When a calibration is hibernated, the software creates a new calibration record, updates the 
standards list, and saves the calibration results as a complete record. What makes a 
hibernated calibration unique is the following: 

• Pass/Fail field C2323 is set to I to indicate that the calibration is incomplete. 
• Found/Left field C2308 is blank to anticipate what may happen when the calibration is 

resumed. 
• The due-Date field C2303 is set to the date of calibration. 
• Hibernation items appear in the calibration recall reports. 
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Resuming a Hibernated Calibration 

 
ggl042.bmp 

When a Manual MET/CAL calibration session starts, any calibration records in hibernation 
display on the calibration screen. To select an item and resume the calibration, click the 
button next to the item. 

Note 
Only one hibernated calibration can be loaded at a time. 

When the resumed calibration is complete and saved, the software creates the new 
calibration record. 

Remote Calibration 

If you do calibrations away from a computer, you can print the datasheet as a form for use 
in the field. Later, after you return and have access to the computer, you can manually 
enter the data into Manual MET/CAL. 

To print a datasheet: 

1. From the Calibrate menu, select Print Datasheet.  
2. Check the datasheets to print, see Figure 22. 
3. Preview or print the datasheet. 

 
ggl067.bmp 

Figure 22. Print Datasheet 
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The Calibration Worksheet is a Crystal report. This report may be modified in Crystal 
Reports. New versions of this report must always have a name that begins with "MMC 
Calibration Worksheet." MMC Calibration Worksheet_2.rpt or MMC Calibration 
Worksheet new.rpt are valid names. The worksheet has a calibration data column for up to 
three items, see Figure 23. 
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Figure 23. Calibration Worksheet 



 Datasheet Edition 
 Calibration 

29 

Saving Calibration Results 

After you input all readings and click the Save button, the Post Cal dialog box displays. 
Use this form to include additional information in the calibration record. 

 
ggl043.bmp 

For each item passing calibration, the due date is set to the calibration date plus the 
calibration interval. For failing items, the due date is set to the calibration date. 

Click the Save button to create a new calibration record for each item. The calibration 
records include the calibration standards used results data. 

Running Calibration Reports 

After saving the calibration results, the Report button enables. To use the report 
functions: 

1. Click the Reports button. This action opens the Batch Reporting screen in 
Figure 24. 

2. Check the reports to run. 

3. Click Preview or Print. The selected report prints for each calibration item. 
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Figure 24. Batch Reporting Screen 

Evaluation of Calibration Results 

When a calibration is complete and you save the results, the software creates a new 
calibration record. Tables 3 through 10 describe how the software evaluates the results 
from a simple four-line datasheet and what is written to the database. 

Table 3. Scenario A As-Found Only - All Tests Pass 

Test Test Results 

1 Pass 

2 Pass 

3 Pass 

4 Pass 

Table 4. Scenario A Database Entries 

Data Field Recorded Value 

C2323 Y (pass) 

C2308 FOUND-LEFT 

Manual MET/CAL As-Found Pass 

Manual MET/CAL As-Left Left blank 
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Table 5. Scenario B As-Found Only - One Test Failed 

Test Test Results 

1 Pass 

2 Fail 

3 Pass 

4 Pass 

Table 6. Scenario B Database Entries 

Data Field Recorded Value 

C2323 N (fail) 

C2308 AS-FOUND 

C2303 Cal Date 

Manual MET/CAL As-Found Fail 

Manual MET/CAL As-Left Left blank 

Table 7. Scenario C As-Found: Fail, As-Left: Pass 

Test As-Found As-Left 

1 Pass  

2 Fail Pass 

3 Pass  

4 Pass  

Table 8. Scenario C Database Entries 

Data Field Recorded Value 

C2323 Y (pass) 

C2308 AS-LEFT 

C2303 Cal Date + Interval 

Manual MET/CAL As-Found Fail 

Manual MET/CAL As-Left Pass 
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Table 9. Scenario D As-Found: Fail, As-Left: Fail 

Test As-Found As-Left 

1 Pass  

2 Fail Fail 

3 Pass  

4 Pass  

Table 10. Scenario D Database Entries 

Data Field Recorded Value 

C2323 N (Fail)) 

C2308 AS-FOUND 

C2303 Cal Date 

Manual MET/CAL As-Found Fail 

Manual MET/CAL As-Left Fail 

Reports 
Manual MET/CAL software supports Crystal Reports the same as 
MET/TRACK software. 

 

Crystal Reports 

To run a Crystal Report: 

1. Click the Reports button on the Toolbar. 

2. Select Crystal Reports. All MET/TRACK reports display in the left window. 

3. Click a report with the mouse to select it.  

4. Push Enter or click the Preview button. Once a report shows in the right panel, it is 
ready to print or export, see Figure 25. 

Calibration report, also known as run-time reports, report on a single defined calibration 
event. These report names begin with the letters “rt_”. To filter the report list to view run-
time reports only, click the Calibration Run-time Reports radio button. 
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Figure 25. Crystal Reports 
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The Results Viewer 

With the Manual MET/CAL software you have a tool that views and compares calibration 
results data. To open the Results Viewer in Figure 26: 

1. Select the Custom Results Viewer from the Tools menu, or push CTRL+R. 

2. Enter an asset number. 

3. Select the calibration date of interest. 

4. Push Enter or click the refresh button to update the display. 

Several data views are available. To select a view, click the view name in the left panel. 

Note 
Only Manual MET/CAL software calibrations support this format. 
MET/CAL software writes to the Full-Results table only. 
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Figure 26. Calibration Results Viewer 

This button adds additional viewers so you can compare the results of different 
instruments or different calibration dates. 

 

Cascade, stack, and tile multiple results viewers. 

 

To re-order the columns of a view temporarily, drag the columns left or right. You can also 
re-name, hide, sort, or re-size a column. Right click a column to select a task. 

Push CTRL+C to send a copy of the information in the viewer to the Windows clipboard. 
Once on the clipboard, you can send a copy to other applications such as Microsoft Excel. 
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Customizing Views 

The standard views in the Custom Results Viewer are generally adequate for most reports. 
However, you can create your own custom view of calibration results data, see Figure 27. 
To create a custom view: 

1. Click . 

2. Enter a name for the view.  

3. Select if the data will come from the Full-results Table or the MMC Table (Manual 
MET/CAL software results table). 

4. To share the view with other MET/CAL® users, check the Public use box. 

 
ggl055.bmp 

Figure 27. Create a Custom View 
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5. Check the results columns that you want to include in the custom view. 

6. To set the column order, click and hold the left mouse button on the column 
description and then drag the column up or down in the list. 

7. To change the name of a results column, push F2 to enable the label editor. 

8. Right-mouse click the field list for sorting options. 

9. Click OK to save the custom view.  

After returning to the Custom Results Viewer, the new custom view name shows in the 
list. Click to select the new custom view. 

Note 
You can rename or delete Custom views at any time. 

Column order and column names may be changed for custom views. To save any changes 
to the custom view, click Save. Custom views must be saved to make them permanent. 
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Information and Reporting 
This section of the manual is about how the Manual MET/CAL software writes calibration 
information to the database. The software uses this information to create new calibration 
certificates and results reports. 

Note 
Manual MET/CAL software uses existing run-time calibration 
reports without modification. The report, Ver_7_Certificates, 
remains the source of this data. 

Existing Reports 

Manual MET/CAL software saves calibration results the same as MET/CAL software to 
insure that existing calibration reports will look the same. Best practice is to read and 
understand the “ResultsTable7.pdf” document before you create a calibration results 
report. It describes each database results field, purpose, and use. This document is usually 
located at C:\METCAL\MANUALS. 

New Reports 

To create a new report for use with Manual MET/CAL software, especially to use the label 
features, it is best to begin by modifying an existing report. 

Included Reports 

Manual MET/CAL Version 2.1 software includes multiple reports. It is suggested that you 
create a dummy datasheet using the Test-Types example datasheet. Then print then reports 
to see how to use the reporting features. 

Results Reporting 

In Figure 28, the Test-Types example datasheet is used to perform a calibration, enter 
results, and save results to the database. 
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Figure 28. Results Reporting 

Note 
• Tests 1.00 and 1.05 are bold labels.  
• Test 1.04 is a blank line. Test 1.09 is a blank line with a label. 
• Test 1.03 has been set to N/A as the test is not relevant, and a comment 

added. 
• Test 1.06 has had the Actual value of the standard entered – see the @ 

symbol. The reading is at the limit and is probably marginal. The 
reading is an average – note the bold blue color 

• The reading for test 1.10 can contain any type of text. 

Viewing Results 
Once a calibration is done and the results are written to the database, it is available for 
reporting and viewing. 
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Custom Results Viewer 
The Custom Results Viewer is available from the Tools menu to display the calibration 
data from the results table in the calibration database. When viewing the results, you can 
see in Figure 29 how the data from the run-time screen is written to the database. 
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Figure 29. Custom Results Viewer 

Options and Customizing 
The options screen is available from the Tools menu. To access the screen in Figure 30 you 
must log-in as the System Manager. 
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Figure 30. Options/Customizing 
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As-Found, As-Left Status Field 

MET/TRACK field C2323 displays the pass/fail status and field C2308 displays the 
Found/Left status of a calibration. Manual MET/CAL software captures both as-found and 
as-left readings at the same time. To clearly indicate the as-found and as-left Pass/Fail 
status, the software is configurable to save this status information in user-designated fields 
independent of the traditional pass/save field. 

In this example, unused fields C2364 will be used for the As-Found results and C2365 for 
the As-Left results. The MET/CAL System Manager can configure the MET/TRACK 
software calibration screen to display these fields. 
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Auto Cert Number Method 

Manual MET/CAL software can enter a certification number for each calibration: 

Manual – Entered manually at run-time. 

Auto Number – Inserts an incrementing number in MET/TRACK field C2395. The initial 
number is 1000 and increments each time the software saves a calibration record. 

Enable Datasheet Approval System 

If checked, the approval system enables. When enabled, both new and updated datasheets 
are set to un-approved and are unavailable. If disabled, all datasheets are available for use 
in a calibration. 

Name + Mfg + Model Must Be Unique 

When unchecked, datasheet names cannot be duplicated. This eliminates the confusion 
caused by two datasheets that have the same name. It also permits the Manufacturer, 
Model, and Description fields to be left blank. 

When checked, the software insures the combination of datasheet name plus manufacturer 
name and model is not duplicated. As shown with the two datasheet names in Table 11, a 
generic datasheet name can be assigned to a datasheet if the manufacturer and model 
names are different. 

Table 11. Unique Datasheet Names 

Name Manufacturer Model 

DATASHEET 123456 Starrett 100-1 

DATASHEET 123456 Starrett 100-2 
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Disable Run-Time As-Left 

Check this option if your organization prefers not to allow the technician to enter As-Left 
calibration. 

Beep When Out of Tolerance 

When checked, the software makes a sound when the technician enters an out-of-tolerance 
value at run-time. 

Customizing the Post Cal Screen 

When a datasheet is complete and you click Save, the Post cal prompts screen displays. 
This screen is customized to include data fields for information you want to record with the 
calibration record. 
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The calibration date, temperature, and humidity fields are required. The additional fields 
added by customization will inherit all MET/TRACK software characteristics, including 
validation, default values, and colors. 

The list of allowed data fields displays in the top window. To select these fields, use the 
down arrow button and push Enter. Selected fields show as a list in the bottom window. 
Notice that the list includes a field’s custom information, see Figure 31. 
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Figure 31. Post Calibration Fields 

Copy From / Copy To 
The Copy From function is set up by the MET/TRACK system manager. In the following 
example, calibration field C2335 has been placed in the calibration screen, and renamed 
Current User. The Source (copy from) has been set to L2801. When a new calibration 
record is created in the MET/TRACK or Manual MET/CAL software, the name of the user 
is added to the calibration record. 

Note 
Copy From fields cannot be used on the post-cal screen. 
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Learning and Experimenting 
When getting started with Manual MET/CAL software, create some sample assets. Keep 
the asset numbers simple and sequential. For example, create four assets with asset 
numbers 1-1, 1-2, 1-3 and 1-4. Set their state to inactive so they will not show up in recall 
and overdue reports. It is also suggested that you have several sample dummy calibration 
standards – Standard 1, Standard 2, Standard 3 and Standard 4. Be sure that these standards 
have calibration records and current calibration dates. 

Initially, the software cannot calibrate without any datasheets. The first step is to create a 
simple datasheet. See, Creating a Datasheet, on page 5 for details. The examples provided 
in the Datasheet Designer are good learning tools. 

It is suggested that you create two datasheets while getting started. Use the examples 
shown in Figure 32 to create the 4 Line datasheet and then the Test-Types datasheet. 
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Figure 32. Sample of 4 Line Datasheet 

After creating and saving, calibrate an asset using this datasheet. In Figure 33, notice that 
Test Step 1.01 is out of tolerance as indicated by the reading shown in red. The As-Left 
column has a data entry for the As-Left in tolerance reading after a calibration adjustment. 
The blue cell background identifies that the out-of-tolerance reading includes a note. 
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Figure 33. Calibration Run-Time Example 

After a calibration is complete and saved, you can view the calibration details by running a 
Crystal Report from the Report menu. The Full Results viewer is also available from the 
Tools Menu. 



 Datasheet Edition 
 Installing a License 

45 

Installing a License 
You must have an installed license to use Manual MET/CAL. The license is a small data 
file with the “LIC” extension. This license ships on the USB Flash Drive with the installer 
program. The License Manager in Figure 34 shows that a five-seat concurrent license is 
installed. 
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Figure 34. License Manager 

To install a license: 

1. Click the Add License button. 

2. Navigate to the license. The license is a small data file with a ".LIC" extension. 

3. Click OK. 
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After installation, the new license is in effect. This is a one-time task. The Details button 
describes each license. 

How to Customize MET/CAL and MET/TRACK 
To list Manual MET/CAL on the MET/CAL or MET/TRACK tool bar, contact the Fluke 
MET/SUPPORT group for details. 

 


	Manual MET/CAL Calibration Management Software  Users Manual
	Table of Contents
	List of Tables
	List of Figures

	Introduction
	New in Version 2.0 and 2.1
	Installation
	Minimum System Requirements
	Security
	First Time Operation
	Licensing

	Languages
	How to Contact Fluke
	Toolbar and Menus
	Datasheets
	Creating a Datasheet
	Creating an Ammeter Datasheet
	Creating a Micrometer Datasheet
	Checks
	Flatness Test
	Length Tests

	Datasheet Designer Wizards
	Single Test Wizard
	Multistep Wizard

	Transducers
	Datasheet Column Descriptions
	Test Type
	Designer Buttons
	Datasheet Designer Hot-Keys
	Checking the Datasheet
	Saving the Datasheet
	Hibernation
	Changing Datasheet Properties
	Making a Copy of a Datasheet
	Instruction Designer
	Saving Instructions
	Attaching Instructions to a Datasheet

	Approving Datasheets
	Setting the Default Datasheet Name

	Calibration
	How to Start a Calibration
	Viewing Calibration Instructions
	Viewing External Calibration Instructions
	Advanced Run-Time Features
	Capturing As�Left Data
	Adding Notes
	Averaging Readings
	Setting a Test to N/A
	Setting the Actual Test Value

	Hibernating a Calibration
	Hibernation Rules
	Resuming a Hibernated Calibration

	Remote Calibration
	Saving Calibration Results
	Running Calibration Reports
	Evaluation of Calibration Results

	Reports
	Crystal Reports
	The Results Viewer
	Customizing Views

	Information and Reporting
	Existing Reports
	New Reports
	Included Reports
	Results Reporting
	Viewing Results
	Custom Results Viewer


	Options and Customizing
	As�Found, As�Left Status Field
	Auto Cert Number Method
	Enable Datasheet Approval System
	Name + Mfg + Model Must Be Unique
	Disable Run-Time As�Left
	Beep When Out of Tolerance
	Customizing the Post Cal Screen
	Copy From / Copy To

	Learning and Experimenting
	Installing a License
	How to Customize MET/CAL and MET/TRACK

